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ABSTRACT 

 

 

 

Heat generation has been a common phenomenon in different mechanical machines. 

Heat dissipation system thus has become more and more important for better 

performance and smooth running of the machine. The dissipation has to be not only 

efficient but also economical and shorter in size. Fins are extended surface which 

increases the surface area of the machine. This project focuses on two types of fins e.g. 

rectangular and cylindrical. The heat flow is simulated by the help of simulation software 

ANSYS 14.0.  The rectangular fin is simulated then verified with the experimental result. 

Then cylindrical fin is simulated and results are compared with the rectangular fin results. 

Thus a generalized methodology is established and can be used to simulate and compare 

other types of fins.  
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CHAPTER ONE 

THEORY: 

1.1 INTRODUCTION 

Heat generation is a common phenomenon in different machines and cycles. This heat 
must be dissipated or removed by some arrangement. The thermal efficiency to some 
extent depends on the successful removal of heat.  

Fins are considered as a simple and common form of heat transferring arrangement. It is 
used in different machines like refrigerator, condenser, evaporator, heat engines even in 
airplanes too.  

The knowledge of heat flow characteristics through may help to determine the type, size, 
area and no of fins to be used in particular case. Simulation is an effective way to explain 
heat flow characteristics. Successful simulation will produce an ideal condition or future 
reference of fins in different machines in this case condenser.  

As simulation software ANSYS is selected. ANSYS is huge simulation software which 
contains different sub section containing Workbench, CFD, CFM, CFD Flo, ICEM CFD, 
Fluent etc. In this case ANSYS Mechanical Flo 14.0 has been used.  

Fins are of different types.  Rectangular and cylindrical or pin type dominates in case of 
usage. So an experiment based simulation for rectangular fins and a theoretical based 
simulation is done. The theoretical approach is based on the size and dimension of 
rectangular fins. With the reference of the results achieved from the rectangular fin 
simulation, another simulation for the cylindrical fin is done. Then performance, 
effectiveness and efficiency are compared. By this procedure the right type of fin can be 
selected for any other purpose.  

1.2 FINS 

Fins are the extended surface attached to different heat producing machines to exchange 
heat with the atmosphere and hence create a cooling effect in the machine. The amount 
of conduction, convection, or radiation of an object determines the amount of heat it 
transfers. Increasing the temperature difference between the object and 
the environment, increasing the convection heat transfer coefficient, or increasing 
the surface area of the object increases the heat transfer. Sometimes it is not 
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economical or it is not feasible to change the first two options. Adding a fin to an object, 
however, increases the surface area and can sometimes be an economical solution to 
heat transfer problems. 

There are different types of fins used in different purposes. Different names have been 
given to fins according to their purpose of use and shape. Some of them are:  

1. Rectangular  
2. Cylindrical/ Pin type 
3. Annular 
4. Grid 

But in this case focus has been paid particularly to rectangular and cylindrical fins. 

1.3 Rectangular Fins 

Fins those are rectangular in shape can be treated as rectangular fins. It has base and 
tip in it. Normally heated end is considered as base and the tip is the conductive or 
convective end. Normal rectangular fin may look like the following figure:  

 

Fig: 1 

But in this case, due to the presence of condenser tube the base is assumed to be a half 
circle. The radius of the half circle will be equal to the outer radius of the condenser 
tube. The following figure is the actual figure that has been used in simulation.  
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Fig: 2 

1.4 Cylindrical Fins 

Fins those are cylindrical in shape can be treated as cylindrical (or pin) fins. It also has 
base and tip in it. Normally heated end is considered as base and the tip is the 
conductive or convective end. Normal cylindrical fin may look like the following figure:  

                                                 

 

Fig: 3 
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1.5 ANSYS 

1.5.1 ANSYS Mechanical Flo 

ANSYS is simulation software used widely for different purposes. It has many 
subsections as stated before. In example: Fluent, ICEM CFD, Workbench, CFM, CFD 
Flo etc. Normally in case of heat flow simulation, CFD based software are used 
worldwide. In case of CFD simulation it is necessary to consider the fluid flow and 
fluid characteristics, but to concentrate specially on fins a simple CFD software named 
ANSYS Mechanical FLO is available. In this thesis, this software is used. As ANSYS 14.0 
version is the latest software available right now so the result may be considered as 
the most accurate possible.  

ANSYS Mechanical Flo-14.0 normally is 2-d software with high performance and 
easier user interface. As fins have very short width, so it does not have a huge effect 
which should be considered. So it was easy to neglect that axis containing width. In 
case of rectangular fins 2-d design is very easily done. But in case of cylindrical fins, 
the axis is considered, and the calculation is done according to that.  

The general purpose fluid analysis tools are the renowned ANSYS CFX and ANSYS 
FLUENT products, now also available together in the ANSYS CFD bundle. ANSYS CFD 
have access to an unprecedented array of fluid flow physics models, allows analyzing 
equipment with a great deal of confidence. ANSYS CFD technology is highly-scalable, 
allowing for efficient parallel calculations on thousands of processing cores. ANSYS 
CFD also includes the full-featured ANSYS CFD-Post fluid flow post-processing tool. 
This can be used for advanced quantitative analysis and high-quality visualizations. 
When ANSYS CFD is used in combination with ANSYS Mechanical it is eminently 
suitable to solve complex fluid-structure interaction problems.  

1.5.2 ANSYS CFD  

Computational fluid dynamics (CFD) is an engineering method in which flow fields and 
other physics are calculated in detail for an application of interest. ANSYS uses a 
multidisciplinary approach to simulation in which fluid flow models integrate 
seamlessly with other types of physics simulation technologies. The CFD or fluids 
simulation results can be used to illustrate how a product or process operates, to 
troubleshoot problems, to optimize performance and to design new products.  

http://www.mallett.com/ansys-processing-solutions.php#1
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ANSYS CFD provides access to both the well-known ANSYS FLUENT and ANSYS CFX 
products. Also available separately, these are the main general-purpose fluids 
simulation products offered by ANSYS. These two core fluids simulation solvers 
represent more than 1,000 person-years of research and development. This effort 
translates into the key benefits of fluids  

ANSYS which enables product design and analysis in a virtual environment has 
revolutionized fluid dynamics by automating the solution, even for problems that are 
numerically large. By identifying physical forces and flow characteristics that are 
sometimes impossible to measure or gain insight into, CFD solutions from ANSYS can 
help a company dramatically improve time to market, slash development costs and 
fulfill critical product promises. 

1.5.3 ANSYS CFD Flo 

ANSYS CFD-Flo is integrated into the unified ANSYS Workbench platform. This easy-to-
use platform provides you access to bi-directional parametric CAD connections, 
powerful geometry and meshing tools, an automated project level update 
mechanism, pervasive parameter management, and integrated optimization tools. 
Key benefits include: 

To quickly prepare product/process geometry for flow analysis without tedious 
rework To avoid duplication through a common data model that is persistently shared 
across physics beyond basic fluid flow To easily define a series of parametric 
variations in geometry, mesh, physics and post processing, and to automatically get 
new CFD results for that series after a single mouse click To improve product/process 
quality by increasing the understanding of variability and design sensitivity 

1.6 Mesh  

Meshing is an important tool in simulation process. It divides the whole heat 
conducting surface into small divisions. The whole heat transfer equation is applied into 
each of these divisions. So the software solves the equation for numerous times. Mesh 
size can be selected by the user. Some predetermined meshing characteristics are also 
available in the software such as prism, triangle, tetra and quad mesh. In this case, quad 
mesh with global attributes is selected.  
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1.7 Loads 

Loads are very important in case of heat transfer and flow. In this particular simulation, 
the loads are the temperature of the fin at the base. The spline curved base (rectangular 
fin) contains the temperature load. The initial temperature was given at that curve. The 
base of the cylinder is a circular surface. One end of the cylinder is considered as base 
and the temperature input is given there.  

In both cases, the initial temperature is 52 ° C or 325 K.  

Loads also contain the convective heat transfer coefficient applied on the surfaces 
except the base. The convective heat transfer coefficient is taken as 40 Wm-2K-1  and the 
bulk temperature is 30° C. 

 

1.8 Nodal Temperature  

A Probe in ANSYS can return a maximum or minimum result on associated geometry; 
however it does not produce an average value of the result. Using ANSYS will allow 
outputting the temperature distribution in an extremely simple and accurate way. 
This simulation divides the whole fin surface into different temperature region. 

 

 

1.9 Heat Flow  

To analyze heat flow through fins different prospective and figures are available in 
ANSYS. For more visual clarification different approaches such as heat flow vector 
sum, heat flow vector plot, and temperature and distance graph are available. The 
heat flow vector sum figure shows the amount of heat transferred to the surface of 
the fin. According to that the fin surface has been divided into few regions. The heat 
flow vector plot fig shows the direction of the heat that is dissipated from the fin 
surface. To get more precise view of the direction of heat flow from the fin surface 
zoom option can be applied. 
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1.10 Condenser  

Condenser is a device for reducing a gas or vapor to a liquid. In distilling operations, 
the device in which the vapor is transformed to a liquid state is called a condenser. All 
condensers operate by removing heat from the gas or vapor; once sufficient heat is 
eliminated, liquefaction occurs. For some applications, all that is necessary is to pass 
the gas through a long tube to permit heat to escape into the surrounding air. A heat-
conductive metal is commonly used to transport the vapor. A condenser’s efficiency is 
often enhanced by attaching fins to the tubing to accelerate heat removal. Commonly, 
such condensers employ fans to force air through the fins and carry the heat away. In 
many cases, large condensers for industrial applications use water or some other 
liquid in place of air to achieve heat removal. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.britannica.com/EBchecked/topic/226306/gas
http://www.britannica.com/EBchecked/topic/343026/liquid
http://www.britannica.com/EBchecked/topic/258569/heat
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CHAPTER TWO 

BACKGROUND 

2.1 Literature Review 

Due to the high demand for lightweight, compact and economical fins, the 

optimization of the size is of great importance. Therefore, fins must be designed to 

achieve maximum heat removal with minimum material expenditure, taken into 

account, and also with the ease of manufacturing the fin shape. Other studies have 

introduced shape modifications by cutting some materials from fins to make cavities, 

holes, slots, grooves or channels through the fin body to increase the heat transfer 

area and/or the heat transfer co efficient. One popular heat transfer augmentation 

technique involves the use of rough interrupted surfaces of different configurations. 

The surface roughness or interruption aims at promoting surface turbulence that is 

mainly intended to increase the heat transfer co efficient rather than the surface area. 

In reference, another experimental study on the forced heat transfer enhancement 

over a flat surface equipped with square cross-sectional perforated pin fins in a 

rectangular channel was conducted. The experimental results shows that the use of 

square pin fins with the circular perforations lead to the heat transfer and friction loss 

characteristics of a horizontal rectangular channel with hollow rectangular profile fins 

attached over one of its heated surfaces. The study showed a significant 

enhancement of the heat transfer due to the hollow fins.  

 

 2.2 Previous Works 

The heat flow characteristics were analyzed before in various occasions. For referral 

few papers can be taken. 
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2.2 (A): Paper Review 1 

  In “Heat Transfer through fins “, Fluent Inc. (Flow Lab 1-2), April 12, 2007, 

rectangular and triangular fins were analyzed and thus efficiency and effectiveness 

were measured. The solution was solved by FLUENT. 

 

Mesh:  Mesh was done by considering different refinement factors: 

 

 

The mesh was done in the rectangular fin. The whole surface area was divided into 

small grids.  

 
Fig: 4 

 

Graph Plot: 

An X-Y plot was then plotted. The graph represents the temperature distribution 

along the length of the fin. The Paper suggests that a higher sloe can be observed near 
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the base of the fin due to the maximum temperature difference between fin surface 

and the surrounding medium at the base.  

The graph is presented below: 

 

 
Fig: 5 

Contour Plot: 

Then a contour plot was shown for the simplified representation of the temperature 

regions.  The colors in the fin show different temperature regions starting from the 

base of the fin towards the tip of it.  
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Fig: --6 

Comparison: 

Then fin efficiency and effectiveness were measured and compared.  

 
Comparing the results, the theoretical and experimental results are very close and 

there is a very little difference in efficiency and effectiveness between the two 

different shaped fins.  

 

2.2 (B): Paper Review 2 

In “Finite Element Analysis and Experimental Study of Convective Heat 

Transfer Augmentation from Horizontal Rectangular Fin by Triangular 

Perforations” written by Kumbhar D.G., Dr. N.K. Sane, Chawan S.T. has shown an 

analysis by ANSYS 9.0 where temperature variations differed with the presence and 

absence  of perforations.  
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The main jest of this paper gives the methodology of explaining the fin characteristics 

by ANSYS. The temperature v/s distance graph always has been the main 

correspondence of the heat transfer rate.  

  

                            Fig: 7                                                                   Fig: 8 

Then temperature v/s distance graph was plotted with respect to different materials 

and dimension of the perforation. 

 

Fig: 9, 10, 11 
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The graphs plotted here were generated automatically by ANSYS. The command was 

to take a reference line in the surface of the fin then taking the temperature 

differences along that line. The comparison becomes easier when multiple graphs are 

generated for same fin and the graph characteristics differences are visible.  

 

2.3 Summary of Previous Works 

The area of this project is relatively new. So the previous works are not that much of 

an exact help. Hence by the help of these papers a common methodology can be 

established and followed. The first paper is helpful more to analyze the fin 

characteristics and introduction of fin analyzing. The second one is helpful for the way 

of analyzing the fin with ANSYS. The material properties have to be taken as per type 

of fin to be used.  The boundary conditions are very important in this case. The 

boundary conditions are assumed in some cases ideal and in some cases experimental 

values available in different lab experiment results. 

The meshing of the model plays a vital role in the analysis of the fin. The mesh size 

and type must meet the requirement of complete structure. In case of rectangular fin 

the mesh size was very easy to choose. The first paper shows that the meshing is only 

square. As the structure is very simple so the mesh size did not hamper the result or 

analysis. The refinement factor is the degree of refinement needed in case of any 

complex area. The irregular shapes need more refinement than simplified structure. 
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CHAPTER THREE 

THESIS WORK 

3.1 Objectives 

 Simulation of rectangular and cylindrical fin. 

 Comparison of experimental and simulation data in case of rectangular fin. 

 Establish a methodology of simulation of rectangular fin. 

 Establish a process of choosing the best suited fin size and shape for any 

machine. 

 Using the rectangular fin simulation methodology to simulate the cylindrical fin. 

 Simulate the cylindrical fin and compare it with the rectangular fin results. 

 To use the simulation process for other types of fins. 

 To avoid any further experiment to determine the fin shape and size. 

3.2 Model 

3.2.1 Rectangular fin 

Dimension: Length – 0.0177 m 

                      Height—0.009 m 

                      Diameter of the condenser pipe or Radius of the spline curve—0.009m 

The rectangular fins are mounted on the condenser pipe vertically. The base of the fin 

hence makes a curvature as per the radius of the condenser pipe. So the fin base area 

must be calculated taking considering this condition. All the dimensions are achieved 

by measuring the fin size with help of slide calipers. The machine is universal air 

condition testing bench in the laboratory. 
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Fig- 12: 3-D model of rectangular fin with dimension 

 

3.2.2 Cylindrical fin 

The dimension of the cylindrical fin is achieved by calculation. As the cylindrical part of 

the simulation is entirely a theoretical approach so for the simplicity of calculation the 

area of the cylindrical fin is taken equal to the area of the rectangular fin. The area of 

the rectangular fin is,  
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A= (height X length) – half circle area 

   = (0.009 X 0.0177) – (½ 𝜋 X 0.00452) 

   = 1.593X10-4 – 3.18X10-5 

   = 1.275X10-4 m2  

Taking this area equal to the cross sectional area of the cylindrical fin. Keeping the 

length of the cylinder equal to the length of rectangular fin, the radius is measured. 

Cross sectional area of the cylinder=1.275X10-4 m2  

Or, 𝜋𝑟2= 1.275X10-4 m2 

Or, r= 6.37X10-3 m 

So the diameter of the cylinder is 0.013 m. The model is then designed.  

 

Fig 13: 3-D model of cylindrical fin with dimension  
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3.3 Boundary Conditions  

 Steady state 

  Uniform cross sectional area 

  No internal heat generation in fin 

  Constant material properties 

  One dimensional conduction 

  Uniform convection across the surface area 

 For this particular condenser the fins are made of ALUMINIUM. 

 The inlet (or fin base) temperature: 52° C/325K  

 The specific heat of Aluminium:  910 J/Kg K  

 The convective heat transfer coefficient of air:  40 W/m² K  

 Thermal Conductivity of aluminium:  205 W/m-K 

 Density of aluminium: 2700 kg/m3  

 

3.4 Solver and Solving Equations 

• Simplified Case:  

  

Nomenclature: 

Ac = Cross sectional area of differential element 

As = Surface area of differential element 

 h = Convection co efficient 

 k = Fourier Constant 

 T = Temperature of the base  

 T∞ = Temperature of the atmosphere 



ISLAMIC UNIVERSITY OF TECHNOLOGY (IUT), GAZIPUR, BANGLADESH. 27 

 

   

 Convective tip: 

 

Nomenclature: 

h = Convection co efficient 

p = Perimeter 

k= Fourier Constant  

Tb = Temperature at base 

T∞ = Temperature of atmosphere 

Ac = Cross sectional area of differential element 

Lc = Effective length= L+ Ac /2  

L= Actual length of fin   
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CHAPTER FOUR 

METHODOLOGY 

4.1 Rectangular Fins 

4.1.1 Building Model: 

1. First of all the preferences was selected for the simulation. In this case it was 
thermal.

 
2. Then the proper element type was selected for designing purpose by following 

order- 
Preprocessor >Element type >Add/Edit/Delete > (Add) >Thermal Mass >Solid > 
Quad 4 node > OK.

 
3. As experiments were conducted on Aluminium fins, so proper material 

properties were given by following order-
Preprocessor > Material properties > Material models > Thermal >  
Enter Conductivity > Isotropic > KXX = 205> OK 
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Preprocessor > Material properties > Material models > Thermal >  
Enter Specific Heat > C = 910 >OK 
Preprocessor > Material properties > Material models > Thermal >  
DENS >2700 > OK 

 
4. Then for creating the model different coordinates of keypoints were put 

(Preprocessor >Modeling > Create >Keypoints> In Active CS). The coordinates 
were-  
Keypoint 1- (0, 0)                                                                                                                                      
Keypoint 2- (.0177, 0) 
Keypoint 3- (.0177, .0092) 
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Keypoint 4- (0, .0092) 
Keypoint 5- (.0046, .0046).

 
5. Now lines were made by connecting one keypoint with another. 

(Preprocessor >Modeling >Create>Lines >Straight Lines> select keypoints> ok) 3 
lines were formed with the help of Keypoint 1,2,3,4.

 
6. Next a spline was created with the help of keypoint1, 4& 5. The steps were - 

Preprocessor >Modeling >Create>Lines > Spline through Keypoints> select 
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Keypoints > ok.

 
7. Then the full structure was converted into an area. The steps were- 

Preprocessor >Modeling >Create>Areas >Arbitrary >By Lines > Select all 
lines>ok.

 
8. Now for meshing, first the length of the fin was divided into 100 no of element 

divisions and the width of the fin was divided into 50 no of element divisions. 
Steps-Preprocessor >Meshing >Mesh Tool >Size controls-Lines-set. 
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9. Global mesh attributes and quad free meshing options were selected for 
meshing in the mesh tool options. 
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10. Then the meshing was done by selecting the fin area. Steps- 
Preprocessor >Meshing >Mesh Tool >Mesh >Pick the whole area > ok.

 

4.1.2 Defining Loads& solve: 

11. In the next stage loads were defined on the fin. For giving fin base temperature the 
spline curve was selected and the initial base temperature (52˚C or 325K) was given. 
steps were- 
Preferences> Preprocessor > Loads > Thermal > Temperature > On Lines > Select the 
spline curve >ok > Load TEMP value= 325 > o 
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12. Heat was transferred by convection through all planes of the fin. So convective 
heat transfer co efficient & ambient temperature was given. 
Steps were- 
Preferences> Preprocessor > Loads >Define Loads > Thermal > Convection >on 
lines> select all planes except base>ok > Film Coefficient =40, Bulk 
Temperature=30 > ok. 

 
 

13.  In the next stage the initial condition was defined for fins. Steps were- 
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Preferences> Preprocessor > Loads >Define Loads > Initial Condit’n>Define > 
Pick All >DOF to be specified=TEMP > Initial value of DOF=30 > OK.

 
14. In the end with the help of ANSYS solver the solution was done. Steps- 

Preferences >Solution > Solve > Current LS > OK. 
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4.2 Cylindrical Fins 

4.2.1 Building Model: 

1. First of all the preferences was selected for the simulation. In this case it was 
thermal.

 

2. Then the proper element type was selected for designing purpose by following 
order- 
Preprocessor >Element type > Add/Edit/Delete > (Add) > Thermal Mass >Solid >
   (Tet 10node 87) > OK.

 
3. As experiments were conducted on Aluminium fins, so proper material 

properties were selected. Steps – 
Preprocessor > Material properties > Material models > Thermal >  
Enter Conductivity > Isotropic > KXX = 205 > OK 
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Preprocessor > Material properties > Material models > Thermal >  
Enter Specific Heat > C = 910 >OK 
Preprocessor > Material properties > Material models > Thermal >  
DENS >2700 >OK. 

 

 

 
4. For creating cylinder following steps were taken- 

Preprocessor >Modeling > Create > Volumes > Cylinder > Solid cylinder > 
 WP X = 0,  
 WP Y = 0, 
 Radius = 0.0064,  
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Depth = 0.0177> ok. 
A solid cylinder was created whose cross sectional area was equal to the cross 
sectional area of the rectangular fin. 

 

 
 

5. Now for meshing the smart size option was turned on from mesh tool options 
and smart size 4 was chosen. Then using free volumetric tetra mesh option the 
mesh operation was done. Steps- 
Preprocessor > Meshing > Mesh tool > Turn on smart size to 4 > Mesh > Volume
s > Mesh > (Pick the body) > OK. 
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4.2.2 Defining loads and solves: 

6. Now for giving thermal temperature the fin base was selected and the initial 
base temperature was given. Steps- 
Preferences> Preprocessor > Loads > Thermal > Temperature >On Areas >Pick 
the area >OK > DOF to be constrained=TEMP >Load TEMP value=325 > OK. 



ISLAMIC UNIVERSITY OF TECHNOLOGY (IUT), GAZIPUR, BANGLADESH. 40 

 

 

 
 

7. Heat was transferred by convection by all areas except fin base area. So 
choosing appropriate areas convective heat transfer co efficient and the 
ambient temperature was given. Steps- 
Preferences> Preprocessor > Loads >Define Loads > Thermal > Convection >On 
areas >Pick all areas except fin base >OK > Film co efficient=40 > Bulk 
Temperature=30 >OK. 
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8. In the next stage the initial condition was defined for fins. Steps were-
Preferences> Preprocessor > Loads >Define Loads > Initial Condit’n>Define > 
Pick All >DOF to be specified=TEMP > Initial value of DOF=30 > OK. It was the 
initial temperature of the fin that’s why entire fin elements were selected.  
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9.  At the last stage with the help of ANSYS solver the solution for the operation 
was done. Steps- 
Preferences >Solution > Solve > Current LS > OK. 
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CHAPTER FIVE 

RESULTS 

5.1 Available Solutions 

Result is analyzed in different solution manners. Here in this thesis few solutions are 

considered, they are: 

1. Nodal Temperature analysis (gives the temperature at different points of the 

surface) 

2.  Heat Flow Analysis (gives the amount of heat flow with respect to distance) 

3. Thermal Gradient Vector Plot (gives the thermal gradient with respect to 

distance)   

4. Thermal Gradient Vector Sum (gives the thermal gradient sum with respect to 

distance)   

5. Thermal Flux Vector Plot (gives thermal flux plot characteristics) 

6. Thermal Flux  Vector Sum (gives thermal flux sum characteristics) 

7. Volumetric Element Solution (gives the temperature difference summation 

according to volume) 

8. Temperature Vs. Distance graph (a graph plotted for temperature with respect to 

distance) 

9. Distance Vs. Thermal Flux graph ( a graph plotted for thermal flux with respect to 

distance) 

10. Distance Vs. Thermal Gradient graph (a graph plotted for thermal gradient with 

respect to distance) 

11.  Thermal flux vs. Temperature graph 

12.  Thermal Gradient vs. Temperature Graph 

13.  Thermal gradient vs. Thermal flux Graph 
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5.2 Rectangular Fin: 

5.2.1 Nodal temperature: 

 

Fig: 14 

5.2.2 Heat Flow  

 

Fig: 15 
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5.2.3 Thermal Gradient Vector Plot 

 

Fig: 16 

Zoomed  
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5.2.4 Thermal Gradient Vector Sum 

 

Fig: 17 

5.2.5 Thermal Flux Vector Plot 

 

Fig: 18 
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Zoomed 

 

5.2.6 Thermal Flux Vector Sum 

 

Fig: 19 
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5.2.7 Volumetric Element Solution 

 

 

Fig: 20 
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5.2.8 Temperature vs. Distance graph (Fig: 21) 

Distance taken from the (0, 0) point of the fin 

 

Distance taken from the middle point  
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5.2.9 Distance vs. Thermal Flux graph 

 

Fig: 22 
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5.2.10 Distance vs. Thermal Gradient graph 

 

Fig: 23 

5.2.11 Thermal flux vs. Temperature graph 

 

Fig: 24 
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5.2.12 Thermal Gradient vs. Temperature Graph 

  

Fig: 25 

5.2.13 Thermal gradient vs. Thermal flux Graph 

 

Fig: 26 
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5.3 Cylindrical/Pin Fin: 

5.3.1 Nodal temperature: 

 

Fig: 27 

5.3.2 Heat Flow  

 

Fig: 28 



ISLAMIC UNIVERSITY OF TECHNOLOGY (IUT), GAZIPUR, BANGLADESH. 54 

 

5.3.3 Thermal Gradient Vector Plot 

 

 

 

 

Fig: 29 
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5.3.4 Thermal Gradient Vector Sum 

 

Fig: 30 

Zoomed 
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5.3.6 Thermal Flux Vector Sum 

 

Fig: 31 

Thermal Flux Vector Sum ZOOM 
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5.3.7 Volumetric Element Solution 

 

Fig: 32 
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5.3.8 Temperature vs. Distance graph 

 

Fig: 33 

5.3.9 Distance vs. Thermal Flux graph 

 

Fig: 34 
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5.3.10 Distance vs. Thermal Gradient graph 

 

Fig: 35 
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5.3.11 Thermal flux vs. Temperature graph 

 

Fig: 36 

5.3.12 Thermal Gradient vs. Temperature Graph 

 

Fig: 37 
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5.3.13 Thermal gradient vs. Thermal flux Graph 

 

Fig: 38 
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CHAPTER SIX 

RESULT ANALYSIS AND COMPARISON 

6.1 Available Results 

The simulation process yields different sets of results as shown in Result chapter. For 
comparison and analysis few results has been chosen here. These are: 

1. Nodal Temperature 
2. Distance vs. temperature graph 
3. Distance vs. thermal flux graph 
4. Distance vs. thermal gradient graph 
5. Heat Flow rate 

6.2 Nodal Temperature Analysis:  

 

                    Rectangular Fin                                                   Cylindrical Fin 

The base temperature of both the fins is same as the initial temperature 52°C or 325 
K.  As the nodal temperature shows the temperature regions at different distance it 
can be easily seen the tip temperature is 322.891 K in rectangular fin where cylindrical 
fin’s tip temperature is 321.115 K. So the cylindrical fin has more cooling effect on the 
heat transfer than the rectangular fin. 
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6.3 Distance vs. temperature graph: 

 

Rectangular Fin 

 

Cylindrical Fin 
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The software has divided the whole length of the fin into 10 equal lengths. Then it has 
generated a graph automatically by keeping distance in Y axis and temperature in X 
axis. As the rectangular fin has a half circle shaped base, so there are two possible 
graphs. One taken from the center of the circle to the tip and another one is from the 
starting point (0, 0) to the tip. Cylindrical fin does not have that sort of irregularity in 
shape. 

For comparison the graph chosen are: starting point to tip and the cylinder graph.  

From the graph it is clearly seen that the rectangular fin transfers more heat than the 
cylindrical fin. 

6.4 Distance vs. Thermal Flux graph: 

 

Rectangular fin 
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 Cylindrical fin 

Thermal flux is the amount of heat transferred along the area perpendicular to the 
direction of heat flow at unit time. The graphs show that the amount of heat flux 
through the rectangular fin is greater than the cylindrical fin. 
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6.5 Distance vs. thermal gradient graph: 

 

Rectangular fin 

 

Cylindrical fin 

Thermal gradient is the physical quantity that describes in which direction and at what 
rate the temperature changes the most rapidly around a particular location. Unit is 
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Km-1. From the graphs shown above it is very much clear that the rectangular fin is 
giving more as rectangular fin is giving 87.994 K/m whereas cylindrical fin is giving 
56.828 K/m. 

6.6 Heat Flow Rate: 

 

Fig 39: Rectangular fin 
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Fig 40: Cylindrical fin 

The heat flow rate chart shows that rectangular fin has the heat flow rate is 39 W/m 
and cylindrical fin has heat flow rate is 0.73292 W/m. 
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CHAPTER SEVEN 

CONCLUSION 

7.1 Decisions 

 The above simulations, results and comparisons conclusion can be drawn that 

the rectangular fin is better heat dissipating surface than the cylindrical fin. 

 The methodology of this simulation is established and can be used to simulate 

other types of fins. 

 Temperature variations along the distance are the main reference of heat 

flow.  

 By this successful simulation it is easy to select the types and sizes of fin for 

any machine working in any condition.  

 

7.2 Future Recommendations 

 The project work here is very limited as it was first step to provide the analysis 

of fin characteristics. 

 More advanced and developed approach can be made to analyze other types of 

fins. 

 The project focused only on the heat flow through the fin, but a better 

simulation can be made taking the fluid flow through the condenser pipe. 

 The thesis work was limited in 2-D form by using ANSYS Mechanical CFD Flo-

14.0, but for 3-D simulation and better result ICEM CFD may be used. 

 It is expected that the thesis work will continue in the future under the same 

supervisor and more advanced approach will be achieved.  
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